Origin 9.0 Getting Started Booklet
# Table of Contents

1  **Origin Installation and Startup** ................................................................. 1  
   1.1 Introduction ............................................................................................. 1  
   1.2 Installing Origin ...................................................................................... 1  
   1.3 Selecting a User Files Folder ................................................................. 2  
   1.4 Licensing Origin .................................................................................... 3  
   1.5 Registering Origin .................................................................................. 3  
   1.6 Maintenance ........................................................................................... 4  
   1.7 Setting the Origin Display Language .................................................... 4  
   1.8 System Transfers - Deactivating a License ............................................ 4  
   1.9 Uninstalling Origin ............................................................................... 5  

2  **Notes for Upgrade Users** ........................................................................ 7  

3  **Introduction to Origin** ........................................................................... 9  
   3.1 The Origin Project ................................................................................... 9  
   3.2 Hierarchy of Origin Objects .................................................................... 10  
   3.3 Operations and Recalculation .................................................................. 22  
   3.4 Themes and Templates ........................................................................... 24  
   3.5 Sharing Origin Files ............................................................................... 28  
   3.6 Analysis Templates and Batch Processing .......................................... 29  
   3.7 OriginPro ............................................................................................. 31  
   3.8 Programming in Origin ......................................................................... 32  

4  **Origin Resources** ................................................................................... 35  
   4.1 Help Center on OriginLab Website ....................................................... 35  
   4.2 Help Files .............................................................................................. 35  
   4.3 Video Tutorials ...................................................................................... 35  
   4.4 User Forum ........................................................................................... 35  
   4.5 Case Studies ......................................................................................... 36  
   4.6 Graph Gallery ........................................................................................ 36  
   4.7 Wiki Site .............................................................................................. 36  
   4.8 Software Updates .................................................................................. 36  
   4.9 Technical Support ................................................................................ 36  
   4.10 Training and Consulting .................................................................... 37  

5  **Origin Toolbars** .................................................................................... 39  
   5.1 Standard .............................................................................................. 39
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.2 Edit</td>
<td>40</td>
</tr>
<tr>
<td>5.3 Graph</td>
<td>40</td>
</tr>
<tr>
<td>5.4 2D Graph</td>
<td>41</td>
</tr>
<tr>
<td>5.5 3D and Contour Graph</td>
<td>43</td>
</tr>
<tr>
<td>5.6 3D Rotation</td>
<td>44</td>
</tr>
<tr>
<td>5.7 Worksheet Data</td>
<td>44</td>
</tr>
<tr>
<td>5.8 Column</td>
<td>45</td>
</tr>
<tr>
<td>5.9 Layout</td>
<td>45</td>
</tr>
<tr>
<td>5.10 Mask</td>
<td>46</td>
</tr>
<tr>
<td>5.11 Tools</td>
<td>46</td>
</tr>
<tr>
<td>5.12 Object Edit</td>
<td>47</td>
</tr>
<tr>
<td>5.13 Arrow</td>
<td>48</td>
</tr>
<tr>
<td>5.14 Style</td>
<td>48</td>
</tr>
<tr>
<td>5.15 Format</td>
<td>49</td>
</tr>
<tr>
<td>5.16 Auto Update</td>
<td>49</td>
</tr>
<tr>
<td>5.17 Database</td>
<td>50</td>
</tr>
<tr>
<td>5.18 Markers &amp; Locks</td>
<td>50</td>
</tr>
</tbody>
</table>
1 Origin Installation and Startup

1.1 Introduction

Welcome, and thank you for using Origin! In this guide, unless otherwise noted, "Origin" will refer to both Origin and OriginPro.

Origin is a Windows application. You can run Origin on an Intel-based Mac if you have installed virtualization software and set up a virtual computer running Microsoft Windows. For more information, see the OriginLab website (www.originlab.com).

There are three steps that must be completed to prepare Origin for use:

- Installation
- Selection of a User Files folder
- License management

1.2 Installing Origin

Both the Origin upgrade and the full product install into a new program folder. Origin does not overwrite previous versions when upgrading, so your original version does not have to be installed when running the upgrade.

The startup program that launches when you insert the Origin DVD includes an Origin installation button. If the startup program does not automatically run, you can browse the DVD to launch the startup program (or the installer).

In addition to the script-based Origin installer that runs from the DVD startup program, an MSI installer and sample transform are provided from the Support|Help Center on the OriginLab website. The MSI installer is ideal for use at multi-user sites, as it can be used to build an Origin installation package for distribution.

For more information on multi-user site deployment, see the OriginLab website Help Center (originlab.com/HelpCenter).

Installing on a 64-bit Computer

When installing on a 64-bit computer, you have the option to install 32-bit or 64-bit Origin, or both. The 64-bit version has much more memory at its disposal, so it is useful for large data sets. However, some data import formats are only available in 32-bit Origin. See the Support area of the OriginLab website for more information about 32-bit versus 64-bit installations.
1.3 Selecting a User Files Folder

If you install 32-bit only (or 64-bit only), and you later want to install 64-bit (or 32-bit), run the Origin Add or Remove Files program located in the Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator permissions). When the Origin setup program starts, select the Modify option.

How to Proceed if You Already Have the Origin Evaluation Installed

If you already have the evaluation version of Origin installed on your computer, you can convert it to the full product or upgrade. To do this, run the Origin Add or Remove Files program located in the Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator permissions). When the Origin setup program starts, select the Modify option and then select Install Product (requires serial number).

How to Correct or Change your Serial Number After you Complete an Installation

If you installed Origin with an incorrect serial number, you can correct it by running the Origin Add or Remove Files program located in your Origin program icon folder, or rerun the Origin installer (both require a log in account with administrator permissions). When the Origin setup program starts, select the Modify option and then click Yes to change your serial number.

1.3 Selecting a User Files Folder

After installing Origin, each Windows log in user must select a User Files folder at the first Origin startup. The User Files folder is the default location for saving and opening files for that log in user.

Consider these points in selecting your User Files folder:

- If you have a mobile computer, it is best to select a User Files folder location on your computer rather than on your network.
- For non-mobile computers, you can select a User Files folder location on the computer or the network, as long as you have stable access to the folder.
- Do not select the same User Files folder as other Origin users. To learn how to share custom files with other Origin users, please review the Origin Help file.
- If you upgraded from an earlier version of Origin, you must select a User Files folder different from your previous installation's User Files folder. To transfer files from your previous installation's folder, click **Tools**, and then click **Transfer User Files**.
At each Origin startup, Origin will check that your User Files folder is accessible. If Origin cannot connect to the User Files folder, you must select a new folder at startup. Also, you can change your User Files folder when you are running Origin. From the Tools menu, click Options and then click the System Path tab.

### 1.4 Licensing Origin

All Origin packages include license management. The type of license management provided with your package is determined at the time of your Origin purchase.

**Node-locked**

Each Origin computer requires a license to run Origin. The license is obtained from the OriginLab website using a licensing "wizard" provided when you start Origin. This process requires a log in account with administrator permissions. Instructions are provided for computers with no internet access.

**Concurrent Network**

Each Origin computer must connect to a FLEXnet license service to run Origin. Your IT department or Origin administrator installs a FLEXnet license server provided by OriginLab (available from the Origin DVD), obtains a license for this server from the OriginLab website, and then sets up a license service. The license service counts and restricts the number of Origin computers that can run concurrently.

For more information, see the OriginLab website Help Center (originlab.com/HelpCenter).

**Dongle**

A dongle (USB hardware key) is provided with the Origin package and must be present in the computer's USB port to run Origin. The dongle license is installed by Origin.

### 1.5 Registering Origin

Although registration is optional, it is recommended. Registering Origin is a prerequisite for Origin support from OriginLab and the team of Origin distributors. Registration also activates Origin's Check for Updates command (available from the Help menu). Check for Updates allows you to check if patches or updated Help files are available for your Origin installation, and to obtain those updates.

If you have an Origin package with node-locked license management, your Origin installation is automatically registered when you successfully complete the licensing process. To verify this, click About Origin from Origin's Help menu. The About Origin dialog box will display the Registration ID assigned to your Origin package.
1.6 Maintenance

For all other license management packages, a Registration dialog box displays when starting a licensed, but unregistered, Origin installation. Use the Registration dialog box to register your Origin installation on the Origin website. During this process, a Registration ID is issued. Enter, or copy and paste, this Registration ID into the Registration dialog box to complete the process. The About Origin dialog box will now display your Registration ID.

1.6 Maintenance

Most Origin packages are sold with the first year of maintenance included. Maintenance provides you with free Origin upgrades, and may also include priority technical support, discounts on Origin training and consulting services, and a home use license.

- To check if your Origin package includes maintenance, click About Origin from Origin's Help menu. If your package includes maintenance, the About Origin dialog will show your maintenance expiration date.
- To learn about the benefits of your maintenance, contact OriginLab or your local Origin distributor.

1.7 Setting the Origin Display Language

Origin packages sold to organizations in a limited number of countries, including Japan, Germany, Switzerland, Austria, and Liechtenstein, may support running Origin with English display, or with Japanese or German display. To access this language control, click Help and then click Change Language.

1.8 System Transfers - Deactivating a License

Node-locked Licenses (Computer ID-based)

A system transfer is required if you plan to replace your licensed Origin computer with a different computer.

- If Origin can still run on your computer:

Run Origin. Click Help and then click Deactivate License. After successful license deactivation, your Computer ID will be removed from the OriginLab license server so that you can install and activate on another computer.

- If your licensed Origin computer is no longer available:

Complete the "license/computer transfer" form available from the Support area of the OriginLab website.
Concurrent Networks

A system transfer is only required if you need to replace the FLEXnet license server. A system transfer is not required when replacing an Origin computer.

To obtain a replacement FLEXnet server license file, complete the "license/computer transfer" form available from the Support area of the OriginLab website.

Dongles

A system transfer is not required when replacing a dongle-managed Origin computer.

1.9 Uninstalling Origin

To uninstall Origin, run the Origin Add or Remove Files program located in the Origin program icon folder, or use the Windows Uninstall or change a program tool. In both cases, the Origin Setup program displays providing options to Modify, Remove, or Repair. Select the Remove option and complete the wizard as prompted.

The Remove program deletes all folders and files that were installed by the Origin setup program. It also deletes folders and keys created by the installer in the Windows registry.
2 Notes for Upgrade Users

The Origin 9.0 upgrade installs into a new program folder - the upgrade does not update a previous version. It is therefore not necessary to have a previous version of Origin installed prior to upgrading.

Origin license management is version-specific. Thus, after installing the Origin 9.0 upgrade, you must complete the license management process. A license dialog will be displayed when Origin is launched for the first time, and this dialog will step you through the process.

Origin project files (OPJ files) created in earlier versions of Origin can be opened, updated, and saved in Origin 9.0. We do not recommend, however, opening and working with Origin 9.0 project files in earlier versions of Origin, as you may suffer some loss of information or data that is specific to the new version. For more information, please visit the Support area of the OriginLab website.

If you have custom Origin files from your previous version, such as graph templates, themes, fitting functions, LabTalk Script, or Origin C files, you can transfer them to your Origin 9.0 User Files Folder. From the Tools menu, click Transfer User Files.

Key new features and improvements in Origin 9.0 are listed below. For more information, see the OriginLab website (originlab.com).

- High-performance 3D Graphs using OpenGL
- 3D Parametric Function Plots
- Movie Creation
- Data Filter for Worksheets
- Floating Graphs in Worksheets
- Global Vertical Cursor
- Implicit Function Fitting (OriginPro Only)
- IIR Filter Design (OriginPro Only)
3 Introduction to Origin

3.1 The Origin Project

The Origin project file (.OPJ) combines data, notes, graphs, and analysis results in one flexibly structured document. All components of an Origin project can be interactively accessed when the project file is opened in Origin. Origin project files can also contain attachments of internally saved Microsoft Excel files or links to external Excel files, LabTalk script and Origin C code files, and third-party files.

Combined with the ability to recalculate results on a change of input data or a change of analysis parameter settings, the Origin project can function as an Analysis Template for performing repeat analysis on multiple sets of similar data.

The dockable Project Explorer window in the Origin Interface helps you organize and interact with various components of an Origin project. Components such as workbooks, matrix books, graph pages, and notes windows can be organized in a user-defined folder structure with the flexibility of adding subfolders to any desired level.

You can open only one Origin project file (.OPJ) in a single session. You can, however, append multiple project files from disk, or save a folder and its subfolders to disk as a project file. You can also save individual windows, such as workbooks and graphs, and open them later to add to another project.
Origin’s **Project Explorer** functions similarly to Windows Explorer. You can sort component windows by name, data, size, or time. Using the context menus in Project Explorer, you can access other options, such as displaying Long and Short names, launching a slide show of graphs within a folder, or appending other Origin Project files from disk.

With a good understanding of the features of Origin’s Project Explorer, combined with the features of workbooks and matrix books, you can efficiently organize all your data, graphs, notes, and analysis results in a single project file.

### 3.2 Hierarchy of Origin Objects

The following sections provide basic information on the hierarchy of the workbook, matrix book, and graph window objects in Origin. Further details on the hierarchy of these and other objects can be found in the Origin Help file.
3.2 Hierarchy of Origin Objects

Workbooks

The Origin workbook is organized as a collection of worksheets. A workbook can contain multiple worksheets, also known as layers, each of which has a unique name.

A worksheet contains a collection of columns. A column can be set to one of several data formats, including **Text & Numeric**, **Numeric**, **Text**, **Data**, and **Time**. Note that a single column can contain only one type of data. You can format individual cells or groups of cells in a column by customizing such properties as font, color, or number of decimal digits to display.

All columns have fixed properties (or metadata) displayed in label rows on top, including **Short Name**, **Long Name**, **Units**, and **Comments**. The values of these properties are used to address and represent data columns within the Origin graphical interface. These values are also used for annotation when graphs are created from data stored in the columns. You can also add custom label rows, called User Parameters, to store additional meta data. The User Parameter rows can be assigned arbitrary names.

Numeric data stored in a column can be graphically displayed in the column header in a special label row called Sparklines. A sparkline is a small inset plot of the data in a column, plotted as the dependent variable (Y) against the row number as the independent variable (X). Origin displays sparklines by default when data is imported into the columns. You can turn sparklines on with the **Add Sparklines...** command in the **Column** menu or column context menu.

Worksheet columns also have a **Plot Designation** property that includes the designations **X**, **Y, Z, Y Error**, and **Label**. This plot designation property allows you to quickly create graphs by selecting columns, and is also used by some Origin dialogs to automatically recognize and assign input data for operations such as curve fitting.
3.2 Hierarchy of Origin Objects

A **Column Properties** dialog is available to customize numerous column properties including name, plot designation, format, and subformat. Double-click or right-click the column header to access the **Column Properties** dialog.

The **Set Column Values** entry in the **Column** menu opens a **Set Values** dialog which can be used to fill a column with values. The formula can refer to other columns in the same sheet, and can utilize various mathematical, statistical, and other functions available from the **F(x)** menu in the dialog. The **Before Formula Script** panel at the bottom of the dialog can be utilized to execute any LabTalk script prior to computation of the main column formula. The **Variables** menu provides a flexible interface in which to insert LabTalk script commands to access columns and other metadata contained in any sheet or book in the Origin Project.

![Set Values Dialog](image)

Various properties of the workbook can be customized using the **Worksheet Properties** dialog, which can be accessed from the **Format** menu. Worksheet cells can contain links to cells in other worksheets or report sheets, and can also contain embedded graphs, images from external disk files, or images corresponding to matrix objects contained in the Origin Project. Groups of cells in a worksheet can be merged, allowing for objects such as embedded graphs to be displayed over a larger area. These features, when combined, allow for the worksheet to be utilized as a flexible document for creating custom reports combining graphs, images, and analysis results. Such custom reports can then be exported as image files, such as PDF or JPEG, and can also be used for presenting results as part of an **Analysis Templates**.
The workbook can contain additional metadata such as properties of data files imported into the worksheet, including variables extracted from header lines contained in the data file. Such metadata can be viewed in the Workbook Organizer panel, which can be accessed through the context menu that opens when you right-click on the worksheet window title. The metadata is then available for access in dialogs such as the Set Values dialog for setting column values.
3.2 Hierarchy of Origin Objects

Matrix Books

The Matrix Book in Origin is a collection of Matrix Sheets or Layers. Each matrix sheet can in turn contain multiple Matrix Objects. Each matrix object is a two-dimensional array of numbers. The data types supported include floating point, integer and complex.
Matrix objects in a matrix sheet can also be viewed as image thumbnails. With the matrix sheet active, select View: Show Image Thumbnails from Origin’s main menu, or from the right-click context menu of the matrix window title bar.

Each matrix object has associated X and Y coordinates. You can assign arbitrary begin and end values for X and Y coordinates, and those values will be used to create a linear map of coordinate values in X and Y. The coordinate values are used by Origin to set the axes when creating plots such as 3D Surface or Contour plots from the matrix data, and also by analysis operations such as surface fitting.

The matrix dimensions, coordinates and X/Y/Z Labels, including Long Name, Units and Comments, can be customized using the Matrix Dimension and Labels dialog. The matrix data type, display, and Z Labels can be controlled using the Matrix Properties dialog. Both dialogs can be accessed from the Matrix menu. All matrix objects contained in a given matrix sheet share the same dimensions properties (number of cells, and X/Y coordinates) and X/Y Labels, although each can have different settings for properties such as data type, display and Z Labels.
The **Set Values** dialog, which can also be accessed from the **Matrix** menu, allows you to specify a formula for generating the numbers in a matrix.
When a matrix contains numeric data, the top right corner of the window displays a D icon. A matrix object can also contain an image, such as an image imported from a disk file, instead of numeric data. When a matrix object contains an image, the top right corner displays an I icon. Basic image processing tools in Origin can operate on images stored in matrix objects. Images can be converted to numeric data and vice versa using menu items under the Image menu.

As mentioned earlier, all matrix objects in a matrix sheet can be viewed as thumbnail images. The bottom panel of the matrix window can display only one matrix object from one matrix sheet at a given time. The display can be toggled between Data Mode and Image Mode, using the View menu. In Data Mode the display can also be toggled to either show the X and Y index or the actual X and Y coordinates, using the View menu.
3.2 Hierarchy of Origin Objects

Virtual Matrix

Data arranged in a group of worksheet cells can be treated as a virtual matrix, and such data can be used to create 3D plots, such as color mapped surfaces or contour plots. The X and Y coordinate values can be contained in data rows/columns or label rows of the worksheet. Nonlinear spacing of X and Y values is supported for a virtual matrix.
Graph

An Origin **Graph Page** can contain multiple **Graph Layers**, where each layer is comprised of a set of axes. Each graph layer can in turn contain multiple **Data Plots**. A **Data Plot** is simply a plot of one data set.

Graph layers can be separate from each other or can physically overlap in the graph page. The axes in one layer can also be linked to axes of other layers. This hierarchy provides a very flexible way to present multiple data plots in one graph in multiple layers, at the same time maintaining desired relationships between the data plots.

The **Plot Details** dialog, which can be accessed from the **Format** menu or by double-clicking on a data plot, provides a hierarchical interface for setting properties of the graph, such as:

- Page level - Page dimensions, colors, legend, etc.
- Layer level - Layer dimensions, linking, colors, etc.
- Data plot level - Specific formatting for each plot style.
Double-clicking on any axis of a layer opens the **Axis Dialog**, which can be used to set properties of the axes such as tick directions, grid lines, and display format of tick labels.
3.2 Hierarchy of Origin Objects

Introduction to Origin 21

The Layer Contents dialog can be accessed by double-clicking or right-clicking on the layer icons displayed on the top left of the graph page. The left panel of the dialog can be used to filter and list available datasets, such as datasets in current worksheet, or entire project. Data can be selected and easily added to, or removed from, the right side panel which represents the layer contents. Controls in the right side panel provide options such as grouping and re-ordering the data plots in the layer. Note that the dialog works on only one layer at a time. If you wish to switch to another layer in your graph, you need to close the dialog and re-open it from the layer icon corresponding to the desired layer.
3.3 Operations and Recalculation

The **Plot Setup** dialog, which can be accessed by right-clicking on the layer icon and selecting **Plot Setup**, provides a flexible interface for adding or removing data plots from any layer in your graph, reordering data plots, and other operations such as grouping or un-grouping plots in a layer. This dialog also opens when the user selects a particular graph template without pre-selecting data columns. In this mode the dialog becomes the primary tool for creating new plots using an existing template, and it offers the flexibility of selecting multiple data sheets in the project. This dialog also allows flexible assignment of data columns, such as the ability to select which column to use for X and which column to use for Y, in the case of a 2D plot.

---

3.3 Operations and Recalculation

Starting with version 8, results of various operations in Origin can be updated when source data is changed, or when a user decides to recall and change parameters of the operation.
This feature is referred to as **Recalculation**. Dialogs for various operations such as setting values of columns based on other columns, extracting worksheet data using conditions on the data, and nonlinear curve fitting of data, all provide control for users to specify whether the **Recalculate** feature should be turned on. Furthermore, users can decide whether the output should update automatically (**Auto**), or update should occur only when manually triggered (**Manual**).

If **Recalculate** is set to **Auto** or **Manual**, Origin saves all pertinent information related to the operation. For instance, if **Recalculate** is set in the **Set Values** dialog for setting column values, information about the source column(s), the formula, and any Before-Formula script are saved. If the operation is related to curve fitting, the details of the operation including source data, what reports have been generated, and all settings relevant to the fitting operation are saved.

Operations that have **Recalculate** enabled are marked by displaying a lock on all output objects such as worksheet columns and graph layers related to the operation. The lock icons appear as in the picture below:

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="lock" /></td>
<td><img src="image2" alt="lock" /></td>
<td><img src="image3" alt="lock" /></td>
</tr>
</tbody>
</table>

A green lock means that output is up to date based on the current data. A yellow lock means that the output is based on previous data, and needs updating. Various options for managing the operation are available via the context menu displayed when clicking on the lock. For example, the user can click on the lock and select **Change Parameters**, which will then display the dialog associated with the operation, loaded with the exact settings used at the time the operation last executed. Users can change the settings and close the dialog to update the output.

The lock icon is object-specific—each worksheet column or graph layer associated with the operation will have its own lock indicating whether the data has been updated or needs updating. There is also a project-level indicator for recalculation on the Standard Toolbar:

<table>
<thead>
<tr>
<th>All Outputs Updated</th>
<th>Outputs Need Updating</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4" alt="lock" /></td>
<td><img src="image5" alt="lock" /></td>
</tr>
</tbody>
</table>

If one or more outputs in the current project need recalculation, this icon will become yellow. Pressing this button will update all operations for which input data has changed. This button is grayed out if recalculation is not active anywhere within the project.
3.4 Themes and Templates

The hierarchy of Origin objects such as graph pages, combined with extensive object properties, lends itself to the creation of custom settings for repeat use. You can save your custom settings either as templates or themes, described briefly in the following sections. For detailed information please refer to Origin Help.

Templates

Customizations performed on objects such as graph pages or worksheets can be saved as templates for repeat use. For example, you can customize a graph page to add multiple layers, set relationships between layers, modify data plot properties, and then save all of these attributes as a graph template (.OTP) file.

Origin ships with over 100 built-in graph templates. You may customize and re-save these templates, or create new templates as desired.

To create a new template from a customized graph, click **File** in the Main Menu, and then click **Save Template As...** To access this template after saving, click **Plot**, and then click **Template Library**.
Origin also extends the template concept to workbooks, matrix books, and analysis templates. You can save workbook or matrix book settings, such as font, color, display format, custom header rows, or dimension and coordinate settings, to .OTW (workbook template) or .OTM (matrix template) files.

Save data operations, even complex operations such as curve fitting with custom report sheets, to an analysis template (.OGW or .OPJ) for repeat analysis of similar data. Analysis templates are explained in more detail in a later section.

**Themes**

An Origin theme is a file containing a set of object properties. These properties could be as simple as axis tick mark direction settings, or as extensive as a collection of multiple graph object properties.

Themes provide the ability to quickly change an object, such as the look of a graph. For example, you may apply a black-and-white theme to a color graph in order to prepare it for publication.

With themes, you can apply object properties from one graph to other graphs in the same project.
Right-click in a graph window, point to **Copy Format**, and then select one of the options from the menu such as **Colors**, **Fonts**, **All Style Formats**, or **All**. Right-click another graph and click **Paste Format** to apply the copied settings to the target graph. This procedure can be applied to single elements, such as copying only the settings of a scatter plot from one graph to another.

The **Theme Organizer** dialog is available in the **Tools** menu. Use this dialog to organize and apply themes to graphs and worksheets. With this dialog you can apply a graph theme to multiple graphs in the Origin project.

To combine multiple themes in the Theme Organizer dialog, hold down **Ctrl** while selecting the themes, and then right-click to access the **Combine** context menu. The context menu in the tool provides an option to edit a theme, allowing the user to add/delete properties to an existing theme.
The theme concept extends to dialog settings as well. You can customize settings of dialogs, such as the Smoothing dialog (available in the Signal Processing menu under Analysis), and then save the settings to disk as a named theme file. You can save multiple theme files for each dialog and then recall them from the dialog. In this way, dialogs can be customized for different purposes such as processing data from different experiments with specific settings.
3.5 Sharing Origin Files

You may want to customize your Origin installation for your specific needs and then share your customizations with other Origin users. Custom settings can be saved in many file types including graph templates (.OTP) and themes (.OTH), analysis templates (.OGW or .OPJ), dialog themes, curve fitting functions, import wizard filters, LabTalk script files (.OGS), and X-Functions.

For a complete list of Origin file types please see Origin Help.

Drag and Drop Sharing

A quick and easy way to share a file with another user is simply to send it as an email attachment. The recipient can then drag and drop the file into the Origin workspace.
Drag-and-drop is supported for most Origin file types. Origin project (.OPJ) and graph template (.OTP) files automatically open when dropped into the workspace. Other files are copied to the appropriate subfolders in the User Files Folder. For example, when you drop a fitting function (.FDF) file into the workspace, a dialog opens asking for the name of the fitting function category to which the new function should be added.

**Sharing Files with Multiple Machines for Single Users**

If you are a single user and have installed Origin on multiple machines, you can share your custom settings across multiple installations. Set up the User Files Folder (UFF) on a shared location, such as a network drive, or even a USB flash drive, and use the same UFF path with each installation.

Please see Origin Help for information on changing the UFF path.

**Sharing Files with Other Users in a Network**

You can set up and use a group folder to share files among users. Multiple groups are allowed, and each group can have a specific user set as the group manager. The group manager can use the **Group Folder Manager** tool to publish custom files for sharing with other group members.

Please see Origin Help for more information.

**Packaging Files**

Origin provides a **Package Manager** tool for packaging multiple files into a single Origin Package (.OPX) file. This is a convenient way to distribute custom applications that may contain multiple Origin files, such as templates, X-functions, and LabTalk script files. The Package Manager includes options for running LabTalk scripts before and after installation.

To access the Package Manager, click **Tools**, and then click **Package Manager**... To install an .OPX file, simply drag and drop into the Origin workspace.

For more information, please see Origin help.

**3.6 Analysis Templates and Batch Processing**

After performing an operation (such as Set Column Values or Nonlinear Curve Fitting), you can save your workbook as an analysis template. Set **Recalculation** to **Auto** or **Manual**, and then click **Save Workbook as Analysis Template**... Origin will clear all input and output data related to the operation and save the workbook as an analysis template (.OGW) file.

To reuse this template, click **File** in the main menu, and then click **Recent Books**. Select your analysis template from the list of recent workbooks to open. You can then import new data into the appropriate source columns, and the output columns and sheets will update automatically if Recalculation was set to Auto, or you can update them manually if Recalculation was set to Manual.
An analysis template workbook (.OGW) can contain multiple related operations. For example, one operation might extract data from the raw data sheet using conditions specified in the Extract Worksheet Data tool, and the next operation might be a nonlinear fitting on the extracted data. In this example, when new data is added to the raw data sheet, the Extract Worksheet operation triggers first. The updated output from this operation then triggers the second operation - the curve fitting. Analysis templates thus provide an easy way to create custom analysis routines, and then reuse them for analysis of similar data.

You can also save an entire Origin project (.OPJ) as an analysis template. This can be useful when your analysis requires more than one workbook, or requires both workbooks and matrix books. To save your Origin project as an analysis template, click File, and then click Save Project as Analysis Template.

Origin provides a tool for performing batch processing of multiple datasets using an analysis template. You can access this tool by clicking File, and then Batch Processing.

The Batch Processing tool can process multiple data files on the disk, or it can process data already in the project, such as multiple Y columns in a worksheet, or multiple XY data curves in multiple sheets or books.

When you create an analysis template, you have the option to add a summary sheet. You can copy output quantities such as parameter values from fitting results, and paste-link them into the summary sheet. The Batch Processing tool can collect the information from the summary sheet, and append it to a report sheet for each dataset. The information in the report sheet can then be further processed or plotted.
Origin provides tutorials which demonstrate how to create and save analysis templates, and then use them to perform batch processing of multiple data files or data sets. To access these tutorials, click Origin’s Help menu, and then click Tutorials.

3.7 OriginPro

OriginPro, the professional version of Origin, provides all of the features of Origin, plus additional analysis tools and capabilities. These include features in the areas of Peak Analysis, Statistics, Signal Processing, Image Processing, and 3D Surface Fitting. Please refer to the Products area of the OriginLab website (www.originlab.com) for more information on OriginPro.

If you have already purchased the standard version of Origin, you can upgrade to OriginPro by contacting your Origin representative.
3.8 Programming in Origin

Origin provides two programming languages:

- **LabTalk**
- **Origin C**

**LabTalk** is a scripting language that provides access to most of Origin’s functionality. With LabTalk you can access and change properties of such Origin objects as worksheet columns, graph layers, and data plots. You can also use LabTalk to access X-Functions to perform tasks such as data importing, data analysis, graph and worksheet exporting, and batch processing.

**Origin C** is a full-featured high-level programming language based on the ANSI C programming language syntax. In addition, Origin C supports a number of C++ features and a few C# features. Origin C provides access to all aspects of Origin, including data import, data handling, graphing, analysis, and exporting. You can access Origin C functions from user interface controls such as buttons, toolbars, and menu items, or by creating X-Function-based dialogs.

Origin ships with a printed LabTalk Scripting Guide and an Origin C Programming Guide. They provide an overview of scripting and Origin C programming, along with numerous examples for all key areas and operations. These guides are also available in Origin’s Help menu. In addition, you can access detailed language reference help files for LabTalk and Origin C from the Help menu.

The OriginLab wiki site ([wiki.originlab.com](http://wiki.originlab.com)) contains the most up-to-date documentation for LabTalk and Origin C.

The choice of which language to use for programming in Origin is mainly a question of complexity of the task. **LabTalk** is well-suited for simple operations, such as importing and manipulating data in worksheet columns, or for performing analysis tasks such as smoothing, interpolation, or curve fitting. In fact, the Set Column Values dialog uses LabTalk script when performing column transformations.

LabTalk scripts can be easily executed from the Command and Script windows, or from toolbar buttons and menu items. Multiple lines of scripts can be saved to a file, optionally organized in sections, and called for execution from the interface. LabTalk scripts can include calls to X-Functions that perform advanced data processing and analysis.

In short, if you are beginning to explore programming in Origin, LabTalk is a good place to start. As your Origin programming needs grow, or if you require advanced customization involving extensive coding, it is recommended that you switch to the Origin C programming environment.

**Origin C** provides access to all Origin objects and properties. Origin C is organized as a set of functions with support for passing arguments. Origin C functions are compiled to object code and then loaded and executed inside of Origin. Origin C provides increased reliability and manageability for developing and debugging code with greater scope and complexity.
Origin C is the language used to create X-Functions. An X-Function is a self-included XML file that can be loaded in Origin as a special type of global function. X-Functions provide a way to expand the functionality of Origin by adding custom data processing features. You can also create custom tools and dialogs with Origin's Developer Kit to build dialog resources, and then use Origin C to access such dialogs within Origin.

In addition to the two programming languages, Origin can also be accessed as an Automation Server. Client applications such as National Instruments LabVIEW, Microsoft Excel, or custom VB/VC/C# applications can exchange data with Origin, and can also send commands to be executed within Origin.
4 Origin Resources

The following sections summarize key Origin resources available to you. If you purchased Origin from a local distributor, your Origin distributor may provide additional resources. Please contact your distributor to learn more.

4.1 Help Center on OriginLab Website

The OriginLab website Help Center (originlab.com/HelpCenter) provides links to installation and license documentation. It also provides links to FAQs, video tutorials, OriginLab user support archives, newsletters and many more support resources.

4.2 Help Files

Help files for various features in Origin, including programming, can be accessed from the Origin Help menu. Help files are typically updated at every service release. To check for availability of updated help files, click Help, and then click Check for Updates.

The most up-to-date versions of our Help files are available in the Support area of the OriginLab website (www.OriginLab.com).

4.3 Video Tutorials

Tutorials are accessible from the Help menu in the product. Video Tutorials are available from the Support area of the OriginLab website. These videos offer an easy way to become familiar with many of Origin’s key features. OriginLab frequently adds new videos, so be sure to check back regularly.

4.4 User Forum

The OriginLab user forum is very active with Origin users asking and answering questions, and sharing tips on using Origin. The forums are monitored by Origin technical staff on a regular basis.

Access the Origin User Forum from the home page of the OriginLab website.
4.5 Case Studies

The OriginLab website provides a collection of case studies, exploring how Origin users in various fields are using key features for their data analysis and graphing needs. We recommend that you view the case study collection for ideas and suggestions about using Origin for your field of work.

4.6 Graph Gallery

The Graph Gallery presents a large collection of graphs, accessible from the home page of the OriginLab website. The graphs illustrate the wide variety of graph templates and advanced customization options available in Origin.

4.7 Wiki Site

The OriginLab wiki site hosts the most up-to-date version of our programming documentation. The wiki site also offers release notes with detailed information on features added in each version and service release.

4.8 Software Updates

OriginLab publishes periodic software updates, called Service Releases, for the current version of Origin. In Origin's Help menu, click Check for Updates to quickly and easily check whether a new service release is available. The Release Notes section of our wiki site provides pertinent information about what features and fixes are available in the current service release.

4.9 Technical Support

OriginLab and our team of international Origin distributors are committed to providing timely and helpful Origin support. If you purchased Origin from a local distributor, please contact your distributor for support. Otherwise, contact Originlab for support. Contact information for both OriginLab and the Origin distributor team is available in the Support area of the OriginLab website. To access these pages from within Origin, click Help, then point to Support, and then click Contact OriginLab Support or Contact your Distributor.

If you have a suggestion for adding or improving a feature in Origin, or if you have found a bug, we want to hear from you. To report a bug or request a feature, click Help, then point to Support, and then click Submit a Feature Suggestion or Submit a Bug Report. You can also notify us from the Support area of the OriginLab website.
4.10 Training and Consulting

OriginLab provides training and consulting services to help customers make optimal use of our products. To learn more about these services, see the Support area of the OriginLab website.
5 Origin Toolbars

Presented below is a list of all toolbars and buttons in Origin. Certain toolbar buttons (or entire toolbars) will be inactive (grayed out) if the object they act on is not present in the Origin Project. For instance, the 3D-Rotation Toolbar is only available when a 3D graph is active.

### 5.1 Standard

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder Icon]</td>
<td>New Project</td>
<td>![Folder Icon]</td>
<td>New Folder</td>
</tr>
<tr>
<td>![Sheet Icon]</td>
<td>New Workbook</td>
<td>![Sheet Icon]</td>
<td>New Excel Workbook</td>
</tr>
<tr>
<td>![Graph Icon]</td>
<td>New Graph</td>
<td>![Graph Icon]</td>
<td>New Matrix</td>
</tr>
<tr>
<td>![Function Icon]</td>
<td>New Function</td>
<td>![Function Icon]</td>
<td>New Layout</td>
</tr>
<tr>
<td>![Notes Icon]</td>
<td>New Notes</td>
<td>![Notes Icon]</td>
<td>Digitize Image</td>
</tr>
<tr>
<td>![Document Icon]</td>
<td>Open</td>
<td>![Document Icon]</td>
<td>Open Template</td>
</tr>
<tr>
<td>![Excel Icon]</td>
<td>Open Excel</td>
<td>![Excel Icon]</td>
<td>Save Project</td>
</tr>
<tr>
<td>![Template Icon]</td>
<td>Save Template</td>
<td>![Template Icon]</td>
<td>Import Wizard</td>
</tr>
<tr>
<td>![ASCII Icon]</td>
<td>Import Single ASCII</td>
<td>![ASCII Icon]</td>
<td>Import Multiple ASCII</td>
</tr>
<tr>
<td>![Batch Icon]</td>
<td>Batch Processing</td>
<td>![Batch Icon]</td>
<td>Recalculate Manual</td>
</tr>
<tr>
<td>![Recalculate Icon]</td>
<td>Recalculate Auto</td>
<td>![Recalculate Icon]</td>
<td>Zoom In and Out by Percentage</td>
</tr>
<tr>
<td>![Print Icon]</td>
<td>Print</td>
<td>![Print Icon]</td>
<td>Slide Show of Graphs</td>
</tr>
<tr>
<td>![PowerPoint Icon]</td>
<td>Send Graphs to PowerPoint</td>
<td>![PowerPoint Icon]</td>
<td>Refresh</td>
</tr>
</tbody>
</table>
5.2 Edit

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Duplicate</td>
<td></td>
<td>Custom Routine</td>
</tr>
<tr>
<td></td>
<td>Project Explorer</td>
<td></td>
<td>Results Log</td>
</tr>
<tr>
<td></td>
<td>Command Window</td>
<td></td>
<td>Code Builder</td>
</tr>
<tr>
<td></td>
<td>Add New Columns</td>
<td></td>
<td>Open Video Builder</td>
</tr>
</tbody>
</table>

5.2 Edit

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Cut" /></td>
<td>Cut</td>
</tr>
<tr>
<td><img src="image" alt="Paste" /></td>
<td>Paste</td>
</tr>
<tr>
<td><img src="image" alt="Copy" /></td>
<td>Copy</td>
</tr>
<tr>
<td><img src="image" alt="Undo" /></td>
<td>Undo</td>
</tr>
</tbody>
</table>

5.3 Graph

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Zoom In</td>
</tr>
<tr>
<td><img src="image" alt="Zoom In" /></td>
<td>Zoom Out</td>
</tr>
<tr>
<td><img src="image" alt="Whole Page" /></td>
<td>Whole Page</td>
</tr>
<tr>
<td><img src="image" alt="Rescale" /></td>
<td>Rescale</td>
</tr>
<tr>
<td><img src="image" alt="Extract to Layers" /></td>
<td>Extract to Layers</td>
</tr>
<tr>
<td><img src="image" alt="Merge" /></td>
<td>Merge</td>
</tr>
<tr>
<td><img src="image" alt="Add Bottom-X Left-Y Layer" /></td>
<td>Add Bottom-X Left-Y Layer</td>
</tr>
<tr>
<td><img src="image" alt="Add Top-X Layer" /></td>
<td>Add Top-X Layer</td>
</tr>
<tr>
<td><img src="image" alt="Add Right-Y Layer" /></td>
<td>Add Right-Y Layer</td>
</tr>
<tr>
<td><img src="image" alt="Add Top-X Right-Y Layer" /></td>
<td>Add Top-X Right-Y Layer</td>
</tr>
<tr>
<td><img src="image" alt="Add Inset Graph With Data" /></td>
<td>Add Inset Graph With Data</td>
</tr>
<tr>
<td><img src="image" alt="Add Inset Graph" /></td>
<td>Add Inset Graph</td>
</tr>
<tr>
<td><img src="image" alt="Add Color Scale" /></td>
<td>Add Color Scale</td>
</tr>
</tbody>
</table>
### 2D Graph

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Line" /></td>
<td>Line</td>
<td><img src="image2" alt="Horizontal Step" /></td>
<td>Horizontal Step</td>
</tr>
<tr>
<td><img src="image3" alt="Vertical Step" /></td>
<td>Vertical Step</td>
<td><img src="image4" alt="Spline Connected" /></td>
<td>Spline Connected</td>
</tr>
<tr>
<td><img src="image5" alt="Scatter" /></td>
<td>Scatter</td>
<td><img src="image6" alt="Scatter Center" /></td>
<td>Scatter Center</td>
</tr>
<tr>
<td><img src="image7" alt="Y Error" /></td>
<td>Y Error</td>
<td><img src="image8" alt="X Y Error" /></td>
<td>X Y Error</td>
</tr>
<tr>
<td><img src="image9" alt="Vertical Drop Line" /></td>
<td>Vertical Drop Line</td>
<td><img src="image10" alt="Bubble" /></td>
<td>Bubble</td>
</tr>
<tr>
<td><img src="image11" alt="Color Mapped" /></td>
<td>Color Mapped</td>
<td><img src="image12" alt="Bubble + Color Mapped" /></td>
<td>Bubble + Color Mapped</td>
</tr>
<tr>
<td><img src="image13" alt="Line + Symbol" /></td>
<td>Line + Symbol</td>
<td><img src="image14" alt="Line Series" /></td>
<td>Line Series</td>
</tr>
<tr>
<td><img src="image15" alt="2 Point Segment" /></td>
<td>2 Point Segment</td>
<td><img src="image16" alt="3 Point Segment" /></td>
<td>3 Point Segment</td>
</tr>
<tr>
<td><img src="image17" alt="Column" /></td>
<td>Column</td>
<td><img src="image18" alt="Column + Label" /></td>
<td>Column + Label</td>
</tr>
<tr>
<td><img src="image19" alt="Bar" /></td>
<td>Bar</td>
<td><img src="image20" alt="Stack Column" /></td>
<td>Stack Column</td>
</tr>
<tr>
<td><img src="image21" alt="Stack Bar" /></td>
<td>Stack Bar</td>
<td><img src="image22" alt="Floating Column" /></td>
<td>Floating Column</td>
</tr>
<tr>
<td><img src="image23" alt="Floating Bar" /></td>
<td>Floating Bar</td>
<td><img src="image24" alt="3D Color Pie Chart" /></td>
<td>3D Color Pie Chart</td>
</tr>
<tr>
<td><img src="image25" alt="2D B&amp;W Pie Chart" /></td>
<td>2D B&amp;W Pie Chart</td>
<td><img src="image26" alt="Double Y Axis" /></td>
<td>Double Y Axis</td>
</tr>
<tr>
<td><img src="image27" alt="3Ys Y-YY" /></td>
<td>3Ys Y-YY</td>
<td><img src="image28" alt="3Ys Y-Y-Y" /></td>
<td>3Ys Y-Y-Y</td>
</tr>
<tr>
<td><img src="image29" alt="4Ys Y-YYY" /></td>
<td>4Ys Y-YYY</td>
<td><img src="image30" alt="4Ys YY-YY" /></td>
<td>4Ys YY-YY</td>
</tr>
<tr>
<td><img src="image31" alt="Multiple Y Axes" /></td>
<td>Multiple Y Axes</td>
<td><img src="image32" alt="Stack Lines By Y Offsets" /></td>
<td>Stack Lines By Y Offsets</td>
</tr>
<tr>
<td>5.4 2D Graph</td>
<td>Waterfall</td>
<td>Waterfall Y: Color Mapping</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>-----------</td>
<td>---------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Waterfall Z: Color Mapping</td>
<td>Vertical 2 Panel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Horizontal 2 Panel</td>
<td>4 Panel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9 Panel</td>
<td>Stack</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Multiple Panels by Label</td>
<td>Box Chart</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Histogram</td>
<td>Histogram + Probabilities</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stacked Histograms</td>
<td>QC(X-bar R) Chart</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Pareto Chart-Binned Data</td>
<td>Pareto Chart-Raw Data</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Scatter Matrix</td>
<td>Probability Plot</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Q-Q Plot</td>
<td>Area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Stack Area</td>
<td>Fill Area</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Polar theta(X) r(Y)</td>
<td>Polar r(X) theta(Y)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Wind Rose-Binned Data</td>
<td>Wind Rose-Raw Data</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Ternary</td>
<td>Smith Chart</td>
<td></td>
</tr>
<tr>
<td></td>
<td>High-Low-Close</td>
<td>Radar</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Vector XYAM</td>
<td>Vector XYXY</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Zoom</td>
<td>Japanese Candlestick</td>
<td></td>
</tr>
<tr>
<td></td>
<td>OHLC Bar Chart</td>
<td>OHLC-Volume</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Template Library</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# 5.5 3D and Contour Graph

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="3D Scatter Plot" /></td>
<td>3D Scatter Plot</td>
<td><img src="image2" alt="3D Trajectory" /></td>
<td>3D Trajectory</td>
</tr>
<tr>
<td><img src="image3" alt="3D Error Bar" /></td>
<td>3D Error Bar</td>
<td><img src="image4" alt="3D Vector XYZ XYZ" /></td>
<td>3D Vector XYZ XYZ</td>
</tr>
<tr>
<td><img src="image5" alt="3D Vector XYZ dXdYdZ" /></td>
<td>3D Vector XYZ dXdYdZ</td>
<td><img src="image6" alt="XYY 3D Bars" /></td>
<td>XYY 3D Bars</td>
</tr>
<tr>
<td><img src="image7" alt="3D Ribbons" /></td>
<td>3D Ribbons</td>
<td><img src="image8" alt="3D Walls" /></td>
<td>3D Walls</td>
</tr>
<tr>
<td><img src="image9" alt="3D Color Fill Surface" /></td>
<td>3D Color Fill Surface</td>
<td><img src="image10" alt="3D X Constant with Base" /></td>
<td>3D X Constant with Base</td>
</tr>
<tr>
<td><img src="image11" alt="3D Y Constant with Base" /></td>
<td>3D Y Constant with Base</td>
<td><img src="image12" alt="3D Color Map Surface" /></td>
<td>3D Color Map Surface</td>
</tr>
<tr>
<td><img src="image13" alt="3D Color Fill Surface with Error Bar" /></td>
<td>3D Color Fill Surface with Error Bar</td>
<td><img src="image14" alt="3D Color Map Surface with Error Bar" /></td>
<td>3D Color Map Surface with Error Bar</td>
</tr>
<tr>
<td><img src="image15" alt="Multiple Color Fill Surfaces" /></td>
<td>Multiple Color Fill Surfaces</td>
<td><img src="image16" alt="Multiple Color Map Surfaces" /></td>
<td>Multiple Color Map Surfaces</td>
</tr>
<tr>
<td><img src="image17" alt="3D Wire Frame" /></td>
<td>3D Wire Frame</td>
<td><img src="image18" alt="3D Wire Surface" /></td>
<td>3D Wire Surface</td>
</tr>
<tr>
<td><img src="image19" alt="3D Bars" /></td>
<td>3D Bars</td>
<td><img src="image20" alt="Contour - Color fill" /></td>
<td>Contour - Color fill</td>
</tr>
<tr>
<td><img src="image21" alt="Contour - B/W Lines + Labels" /></td>
<td>Contour - B/W Lines + Labels</td>
<td><img src="image22" alt="Gray Scale Map" /></td>
<td>Gray Scale Map</td>
</tr>
<tr>
<td><img src="image23" alt="Contour Profiles" /></td>
<td>Contour Profiles</td>
<td><img src="image24" alt="Polar Contour theta(X) r(Y)" /></td>
<td>Polar Contour theta(X) r(Y)</td>
</tr>
<tr>
<td><img src="image25" alt="Polar Contour r(X) theta(Y)" /></td>
<td>Polar Contour r(X) theta(Y)</td>
<td><img src="image26" alt="Ternary Contour" /></td>
<td>Ternary Contour</td>
</tr>
<tr>
<td><img src="image27" alt="Image Plot" /></td>
<td>Image Plot</td>
<td><img src="image28" alt="Image Profiles" /></td>
<td>Image Profiles</td>
</tr>
<tr>
<td><img src="image29" alt="3D Color Map Surface with Projection" /></td>
<td>3D Color Map Surface with Projection</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
5.6 3D Rotation

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Rotate counterclockwise</td>
<td><img src="image" alt="Icon" /></td>
<td>Rotate clockwise</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Tilt left</td>
<td><img src="image" alt="Icon" /></td>
<td>Tilt right</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Tilt down</td>
<td><img src="image" alt="Icon" /></td>
<td>Tilt up</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Increase perspective</td>
<td><img src="image" alt="Icon" /></td>
<td>Decrease perspective</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Fit frame to layer</td>
<td><img src="image" alt="Icon" /></td>
<td>Reset rotation</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Rotate</td>
<td><img src="image" alt="Icon" /></td>
<td>Rotation Angle</td>
</tr>
</tbody>
</table>

5.7 Worksheet Data

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Statistics on Column(s)</td>
<td><img src="image" alt="Icon" /></td>
<td>Statistics on Row(s)</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Sort</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Set Column Values**

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>One column</td>
<td><img src="image" alt="Icon" /></td>
<td>All columns</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Row number</td>
<td><img src="image" alt="Icon" /></td>
<td>Uniform random numbers</td>
</tr>
<tr>
<td><img src="image" alt="Icon" /></td>
<td>Normal random numbers</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Data Filter**
### 5.8 Column

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="X" /></td>
<td>Set as X</td>
<td><img src="image" alt="Y" /></td>
<td>Set as Y</td>
</tr>
<tr>
<td><img src="image" alt="Z" /></td>
<td>Set as Z</td>
<td><img src="image" alt="i" /></td>
<td>Set as Y Error Bars</td>
</tr>
<tr>
<td><img src="image" alt="abc" /></td>
<td>Set as Labels</td>
<td><img src="image" alt="MORE" /></td>
<td>Set as Disregard</td>
</tr>
<tr>
<td><img src="image" alt="G" /></td>
<td>Set as Grouping</td>
<td><img src="image" alt="S" /></td>
<td>Set as Subject</td>
</tr>
<tr>
<td><img src="image" alt="←" /></td>
<td>Move to First</td>
<td><img src="image" alt="→" /></td>
<td>Move Left</td>
</tr>
<tr>
<td><img src="image" alt="→" /></td>
<td>Move Right</td>
<td><img src="image" alt="↔" /></td>
<td>Move to Last</td>
</tr>
<tr>
<td><img src="image" alt="↔" /></td>
<td>Swap Columns</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 5.9 Layout

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="L" /></td>
<td>Add Graph</td>
<td><img src="image" alt="Table" /></td>
<td>Add Worksheet</td>
</tr>
</tbody>
</table>
5.10 Mask

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Mask Range" /></td>
<td>Mask Range</td>
<td><img src="image" alt="Unmask Range" /></td>
<td>Unmask Range</td>
</tr>
<tr>
<td><img src="image" alt="Change mask color" /></td>
<td>Change mask color</td>
<td><img src="image" alt="Hide/Show masked points" /></td>
<td>Hide/Show masked points</td>
</tr>
<tr>
<td><img src="image" alt="Swap mask" /></td>
<td>Swap mask</td>
<td><img src="image" alt="Disable/Enables masking" /></td>
<td>Disable/Enables masking</td>
</tr>
</tbody>
</table>

5.11 Tools

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Pointer" /></td>
<td>Pointer</td>
<td><img src="image" alt="Scale In" /></td>
<td>Scale In</td>
</tr>
<tr>
<td><img src="image" alt="Scale Out" /></td>
<td>Scale Out</td>
<td><img src="image" alt="Screen Reader" /></td>
<td>Screen Reader</td>
</tr>
<tr>
<td><img src="image" alt="Reader" /></td>
<td>Reader</td>
<td><img src="image" alt="Annotation" /></td>
<td>Annotation</td>
</tr>
<tr>
<td><img src="image" alt="Cursor" /></td>
<td>Cursor</td>
<td><img src="image" alt="Data Selector" /></td>
<td>Data Selector</td>
</tr>
<tr>
<td><img src="image" alt="Selection on Active Plot" /></td>
<td>Selection on Active Plot</td>
<td><img src="image" alt="Selection on All Plots" /></td>
<td>Selection on All Plots</td>
</tr>
<tr>
<td><img src="image" alt="Mask Points on Active Plot" /></td>
<td>Mask Points on Active Plot</td>
<td><img src="image" alt="Mask Points on All Plots" /></td>
<td>Mask Points on All Plots</td>
</tr>
<tr>
<td><img src="image" alt="Unmask Points on Active Plot" /></td>
<td>Unmask Points on Active Plot</td>
<td><img src="image" alt="Unmask Points on All Plots" /></td>
<td>Unmask Points on All Plots</td>
</tr>
<tr>
<td><img src="image" alt="Draw Data" /></td>
<td>Draw Data</td>
<td><img src="image" alt="Text Tool" /></td>
<td>Text Tool</td>
</tr>
<tr>
<td><img src="image" alt="Arrow Tool" /></td>
<td>Arrow Tool</td>
<td><img src="image" alt="Curved Arrow Tool" /></td>
<td>Curved Arrow Tool</td>
</tr>
</tbody>
</table>
5.12 Object Edit

### Object Edit

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="image" /></td>
<td>Left</td>
<td><img src="image2.png" alt="image" /></td>
<td>Right</td>
</tr>
<tr>
<td><img src="image3.png" alt="image" /></td>
<td>Top</td>
<td><img src="image4.png" alt="image" /></td>
<td>Bottom</td>
</tr>
<tr>
<td><img src="image5.png" alt="image" /></td>
<td>Vertical</td>
<td><img src="image6.png" alt="image" /></td>
<td>Horizontal</td>
</tr>
<tr>
<td><img src="image7.png" alt="image" /></td>
<td>Uniform Width</td>
<td><img src="image8.png" alt="image" /></td>
<td>Uniform Height</td>
</tr>
<tr>
<td><img src="image9.png" alt="image" /></td>
<td>Front</td>
<td><img src="image10.png" alt="image" /></td>
<td>Back</td>
</tr>
<tr>
<td><img src="image11.png" alt="image" /></td>
<td>Front(data)</td>
<td><img src="image12.png" alt="image" /></td>
<td>Back(data)</td>
</tr>
<tr>
<td><img src="image13.png" alt="image" /></td>
<td>Group</td>
<td><img src="image14.png" alt="image" /></td>
<td>Ungroup</td>
</tr>
</tbody>
</table>
### 5.13 Arrow

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Horizontal Alignment" /></td>
<td>Horizontal Alignment</td>
<td><img src="image" alt="Vertical Alignment" /></td>
<td>Vertical Alignment</td>
</tr>
<tr>
<td><img src="image" alt="Widen Head" /></td>
<td>Widen Head</td>
<td><img src="image" alt="Narrow Head" /></td>
<td>Narrow Head</td>
</tr>
<tr>
<td><img src="image" alt="Lengthen Head" /></td>
<td>Lengthen Head</td>
<td><img src="image" alt="Shorten Head" /></td>
<td>Shorten Head</td>
</tr>
</tbody>
</table>

### 5.14 Style

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Fill Color" /></td>
<td>Fill Color</td>
<td><img src="image" alt="Line/Border Color" /></td>
<td>Line/Border Color</td>
</tr>
<tr>
<td><img src="image" alt="Palette" /></td>
<td>Palette</td>
<td><img src="image" alt="Line/Border Style" /></td>
<td>Line/Border Style</td>
</tr>
<tr>
<td><img src="3.0" alt="Line/Border Width" /></td>
<td>Line/Border Width</td>
<td><img src="image" alt="Fill Pattern" /></td>
<td>Fill Pattern</td>
</tr>
<tr>
<td><img src="0.0" alt="Fill Pattern Width" /></td>
<td>Fill Pattern Width</td>
<td><img src="image" alt="Pattern Color" /></td>
<td>Pattern Color</td>
</tr>
<tr>
<td><img src="image" alt="Clear Borders" /></td>
<td>Clear Borders</td>
<td><img src="image" alt="Left Border" /></td>
<td>Left Border</td>
</tr>
<tr>
<td><img src="image" alt="Top Border" /></td>
<td>Top Border</td>
<td><img src="image" alt="Right Border" /></td>
<td>Right Border</td>
</tr>
<tr>
<td><img src="image" alt="Bottom Border" /></td>
<td>Bottom Border</td>
<td><img src="image" alt="Frame Borders" /></td>
<td>Frame Borders</td>
</tr>
<tr>
<td><img src="image" alt="Inside Horizontal Borders" /></td>
<td>Inside Horizontal Borders</td>
<td><img src="image" alt="Inside Vertical Border" /></td>
<td>Inside Vertical Border</td>
</tr>
<tr>
<td><img src="image" alt="Inside Horiz and Vert Borders" /></td>
<td>Inside Horiz and Vert Borders</td>
<td><img src="image" alt="All Horizontal Borders" /></td>
<td>All Horizontal Borders</td>
</tr>
<tr>
<td><img src="image" alt="All Vertical Borders" /></td>
<td>All Vertical Borders</td>
<td><img src="image" alt="All Borders" /></td>
<td>All Borders</td>
</tr>
</tbody>
</table>
### 5.15 Format

#### Format

```
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🎨</td>
<td>Default: Arial</td>
<td>22</td>
<td>Font size</td>
</tr>
<tr>
<td>✨</td>
<td>Bold (Ctrl+&quot;B&quot;)</td>
<td>✨</td>
<td>Italic (Ctrl+&quot;I&quot;)</td>
</tr>
<tr>
<td>✨</td>
<td>Underline (Ctrl+&quot;U&quot;)</td>
<td>✨</td>
<td>Superscript (Ctrl+&quot;+&quot;&quot;)</td>
</tr>
<tr>
<td>✨</td>
<td>Subscript (Ctrl+=&quot;&quot;)</td>
<td>✨</td>
<td>SuperSubscript (Ctrl+&quot;−&quot;)</td>
</tr>
<tr>
<td>✨</td>
<td>Greek (Ctrl+&quot;G&quot;)</td>
<td>✨</td>
<td>Increase Font (Ctrl+&quot;&lt;&quot;)</td>
</tr>
<tr>
<td>✨</td>
<td>Decrease Font (Ctrl+&quot;&lt;&quot;)</td>
<td>✨</td>
<td>Center Horizontal</td>
</tr>
<tr>
<td>✨</td>
<td>Center Vertical</td>
<td>✨</td>
<td>Right</td>
</tr>
<tr>
<td>✨</td>
<td>Top</td>
<td>✨</td>
<td>Center Vertical</td>
</tr>
<tr>
<td>✨</td>
<td>Bottom</td>
<td>✨</td>
<td>Font Color</td>
</tr>
</tbody>
</table>
```

### 5.16 Auto Update

#### Auto Update

```
<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✨</td>
<td>Auto Update On</td>
</tr>
</tbody>
</table>
```
5.17 Database

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![image]</td>
<td>Open SQL Editor</td>
<td>![image]</td>
<td>Open Query Builder</td>
</tr>
<tr>
<td>![image]</td>
<td>Load ODQ File</td>
<td>![image]</td>
<td>Preview Import</td>
</tr>
<tr>
<td>![image]</td>
<td>Import data</td>
<td>![image]</td>
<td>Remove SQL</td>
</tr>
</tbody>
</table>

5.18 Markers & Locks

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![image]</td>
<td>Add Data Markers</td>
<td>![image]</td>
<td>Clear Data Markers</td>
</tr>
<tr>
<td>![image]</td>
<td>Marker Size</td>
<td>![image]</td>
<td>Marker Hide Show</td>
</tr>
<tr>
<td>![image]</td>
<td>Lock Positions</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>